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Introduction
  Symboles et conventions

Indique que le non-respect d’une action recommandée est susceptible d’endommager 
l'imprimante.

Information qui précise ou enrichit certains points du texte principal.

 

Avancé (Advanced)  > Ajuster (Fit) :

Texte figurant dans  l'interface de Badge Studio et sur lequel vous pouvez cliquer.

Chemin à suivre sur le siteweb Evolis pour accéder à de la documentation ou au fichiers d'installation 
du pilote d'imprimante. 

Fonctions uniquement disponibles dans l'édition PLUS de Badge Studio.

  Comment fonctionne Badge Studio
Un document dans Badge Studio associe la conception de cartes à la gestion de données pour une série 
de cartes au moyen de sa zone de conception de cartes et son tableau de données. Les deux 
fonctionnent en parallèle : une carte au sein de la série correspond toujours à une ligne du tableau de 
données, et les éléments sur le modèle de carte peuvent être liés aux colonnes du tableau de données.

  Conception de carte  

  Pour commencer un nouveau document, sélectionner soit 
un modèle de carte prédéfini soit un modèle de carte 
vierge.

  Puis dans la zone de conception de cartes, ajouter, 
personnaliser, dimensionner et positionner les éléments 
(texte, images, codes-barres et formes) que vous souhaitez 
faire figurer sur les cartes dans votre série de cartes.

Vous pouvez décider des éléments de texte, images, code-
barres qui varient de carte en carte et ceux qui sont 
identiques sur toutes les cartes.

  Gestion des données  

  Dans le tableau de données, modifier les données (texte, 
images, code-barres) qui varient de carte en carte. Ajoutez 
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des lignes pour ajouter des cartes basées sur le même 
modèle de carte et contenant les mêmes éléments que les 
autres cartes.

  Importer des données depuis d'autres documents grâce à 
un assistant.

  Impression  

  Pour imprimer des cartes, sélectionner une, plusieurs ou 
toutes les lignes dans le tableau de données avant de 
configurer et lancer l'impression.

  Ce qu'offre l'édition PLUS
Les éditions STANDARD et PLUS de Badge Studio sont disponibles. L'édition PLUS comprend des 
fonctionnalités supplémentaires par rapport à l'édition STANDARD :

Concevoir une carte recto-verso

Verrouiller les éléments sur la carte par mot de passe

Importer des données

Supprimer des doublons de lignes lors d'importer des données

Verrouiller/Déverrouiller une colonne

Imprimer en recto-verso grâce à un assistant

  Par défaut, la solution Badgy 100 comprend l'édition STANDARD. La solution Badgy 200 comprend 
l'édition PLUS.

Les utilisateurs de l'édition STANDARD peuvent profiter des fonctionnalités supplémentaires en activant 
une licence pour l'édition PLUS..

  Interface d'accueil
L'interface d'accueil s'affiche lorsque vous lancez Badge Studio ou fermez un document.
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Créer un nouveau document

Parcourir les documents récents

 

Ouvrir le document

Renommer le document

Ouvrir un document qui n'est pas 
afficher

Fichier (File) > Ouvrir un document (Open a document)

Changer de langue Fichier (File) > Langues (Languages)
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Installation, licence & versions
Installer le pilote et le logiciel

Exigences minimales

  Système d'exploitation : Windows® / macOS (Charte de compatibilité des logiciels)

RAM : 2GB

Espace libre sur le disque dur : 1.5GB

Résolution d'écran : 1024 x 768 pixels

Connectivité : 1 port USB

Une webcam intégrée compatible avec DirectShow, WIA ou TWAIN

Installer le pilote et le logiciel à partir de la clef USB

 
Toutes les versions de Windows exigent que l’utilisateur dispose des droits administrateurs 
pour installer le pilote.

Ne pas brancher l'imprimante avant que le processus d'installation ne soit terminé.

 1. Une clef USB contenant le pilote et le logiciel est fournie avec la solution.

 2. Ouvrir le contenu de la clef USB par moyen de Windows Explorer / macOS Finder.

 3. Ouvrir le fichier Setup.exe (pour Windows) / Setup.pkg (pour macOS).

Par défaut, ceci lancera l'installation du pilote d'imprimante et le logiciel Badge Studio.

 

 4. Lorsque le processus d'installation est terminé, vous pouvez brancher l'imprimante à votre 
ordinateur par moyen du câble USB.

Installer le pilote et le logiciel à partir d'un téléchargement

 
Toutes les versions de Windows exigent que l’utilisateur dispose des droits administrateurs 
pour installer le pilote.

Ne pas brancher l'imprimante avant que le processus d'installation ne soit terminé.

 1. Aller sur la page Badge Studio sur www.evolis.com > Section support > Page produit.

 2. Cliquer sur la version la plus récente du fichier .exe (pour Windows)  / .pkg (pour macOS).

 3. Cliquer sur Téléchargez (Download).

▶  Le fichier .exe/.pkg est téléchargé sur votre ordinateur.

https://downloads.evolis.com/evolis/documents/evolis-application-software-compatibilty-chart.pdf
https://fr.evolis.com/
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 4. Lorsque le téléchargement est terminé, ouvrir le fichier Setup.exe / Setup.pkg.

Par défaut, ceci lancera l'installation du pilote d'imprimante et le logiciel Badge Studio.

 

 5. Suivre les étapes d'installation à l'écran.

 6. Lorsque le processus d'installation est terminé, vous pouvez brancher l'imprimante à votre 
ordinateur par moyen du câble USB.

Désinstaller Badge Studio

  Windows

 1. Depuis le menu Démarrer de Windows, aller dans le dossier BadgeStudio et sélectionner 
BadgeStudioUninstall.

 2. Cliquer sur Supprimer pour désinstaller le logiciel de l'ordinateur.

macOS

 1. Depuis Applications, mettre Badge Studio dans la corbeille.

 2. Vous devrez supprimer les fichiers de configuration et la liste de documents manuellement.

Gérer le logiciel, les licences / versions

Activer une licence

   1. Acheter une licence pour l'édition PLUS à votre revendeur Badgy.

 2. Depuis Badge Studio, aller dans Fichier (File) > Licence Badge Studio.

 3. Saisir le code d'activation envoyé par votre revendeur.

Si vous avez un code à 64 chiffres, cochez la case correspondante.

 4. Cliquer sur Activer la licence (Activate License).

Activer une licence sur un ordinateur hors ligne

 
Une licence PLUS peut être activée sur un ordinateur à la fois.

Sur l'ordinateur hors ligne :

 1. Insérer une clef USB.

 2. Lancer Badge Studio.

 3. Aller dans Fichier (File)  > Licence Badge Studio.

 4. Cliquer sur Plus d'options de licence (More licensing options), sélectionner 
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Activer/Désactiver la licence hors ligne (Activate / Deactivate license offline) puis cliquer 
sur Activer / Désactiver hors connexion (Activate / Deactivate Offline).

 5. Sélectionner Activer la licence sur cet ordinateur (Activate license on this computer) puis 
cliquer sur Suivant (Next >).

 6. Sélectionner un emplacement sur la clef USB où le fichier .txt généré sera enregistré.

 7. Cliquer sur Suivant (Next >) mais ne pas fermer l'assistant.

 8. Éjecter la clef USB.

Sur un ordinateur connecté à internet avec Badge Studio installé :

 1. Insérer la clef USB.

 2. Lancer Badge Studio.

 3. Aller dans Fichier (File)  > Licence Badge Studio.

 4. Cliquer sur Plus d'options de licence (More licensing options), sélectionner 
Activer/Désactiver la licence hors ligne (Activate / Deactivate license offline) puis cliquer 
sur Activer / Désactiver hors connexion (Activate / Deactivate Offline).

 5. Sélectionner Activer la licence pour un ordinateur hors ligne (Activate license for an offline 
computer) puis cliquer sur Suivant (Next >).

 6. Sélectionner le fichier .txt sur la clef USB.

 7. Saisir le code d'activation envoyé par votre revendeur Badgy.

 8. Cliquer sur Activer la licence (Activate License).

 9. Sélectionner un emplacement sur la clef USB où le fichier .license généré sera enregistré.

 10. Éjecter la clef USB.

Sur l'ordinateur hors ligne :

 1. Insérer la clef USB.

 2. Dans l'assistant ouvert plus tôt, sélectionner le fichier .license sur la clef USB

 3. Cliquer sur Activer la licence (Activate License).

▶  L'assistant activera la licence PLUS sur cet ordinateur hors ligne.

Désactiver une licence

  Une licence activée avec un coupon de mise à niveau peut être désactivée sur un ordinateur connecté à 
internet.

 1. Lancer Badge Studio.

 2. Aller dans Fichier (File) > Licence Badge Studio.

 3. Cliquer sur Plus d'options de licence (More licensing options) et sélectionner Activer / 
désactiver la licence (Activate / deactivate license).

 4. Cliquer sur Désactiver la licence (Deactivate license).

▶  Badge Studio se connecte au serveur de licence pour effectuer la désactivation.
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Désactiver une licence sur un ordinateur hors ligne

  Puisque la licence PLUS peut être activée sur un maximum de un ordinateur hors ligne, il se peut que 
vous ayez besoin de désactiver une licence PLUS sur un ordinateur afin qu'elle puisse être activée sur un 
autre.

Sur l'ordinateur hors ligne avec la licence à désactiver

 1. Insérer une clef USB.

 2. Lancer Badge Studio.

 3. Depuis l'interface d'accueil, cliquer sur Fichier (File) > Licence Badge Studio.

 4. Cliquer sur Plus d'options de licence (More licensing options), sélectionner 
Activer/Désactiver la licence hors ligne (Activate / Deactivate license offline) puis cliquer 
sur Activer / Désactiver hors connexion (Activate / Deactivate Offline).

 5. Sélectionner Désactiver la licence sur cet ordinateur (Deactivate license on this computer) 
puis cliquer sur Suivant (Next >).

 6. Sélectionner un emplacement sur la clef USB où le fichier .txt généré sera enregistré.

 7. Éjecter la clef USB.

Sur un ordinateur connecté à internet avec Badge Studio installé :

 1. Insérer une clef USB.

 2. Lancer Badge Studio.

 3. Depuis l'interface d'accueil, cliquer sur Fichier (File)  > Licence Badge Studio.

 4. Cliquer sur Plus d'options de licence (More licensing options), sélectionner 
Activer/Désactiver la licence hors ligne (Activate / Deactivate license offline) puis cliquer 
sur Activer / Désactiver hors connexion (Activate / Deactivate Offline).

 5. Sélectionner Désactiver la licence pour un ordinateur hors ligne (Deactivate license for an 
offline computer) puis cliquer sur Suivant (Next >).

 6. Sélectionner le fichier .txt sur la clef USB.

 7. Cliquer sur Désactiver la licence (Deactivate license).

▶  La licence sera désactivée et pourra être utilisée pour activer une licence PLUS sur un autre 
ordinateur hors ligne.

Mettre à jour le logiciel vers la version la plus récente

  Depuis Badge Studio, aller dans Aide (Help) > Rechercher les mises à jour logicielles (Check for 
software updates).

 l Si votre logiciel est à jour, une confirmation s'affiche :
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 l Si une mise à jour est disponible

 a. Cliquer sur Téléchargez (Download).

▶  Un fichier .exe (Windows) /.pkg (macOS) est téléchargé sur votre ordinateur.

 b. Ouvrir le fichier .exe / .pkg téléchargé.

 c. Suivre les étapes d'installation à l'écran.

Désactiver la recherche de la dernière version

  Par défaut, Badge Studio recherche la version la plus récente du logiciel en tentant une connexion vers 
un serveur à distance.

 1. Depuis Badge Studio, aller dans Aide (Help) > Rechercher les mises à jour logicielles (Check 
for software updates).

 2. Décocher la case Vérifier automatiquement les mises à jour (Automatically check for 
updates).
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Conception de carte
Zone de conception de cartes

  La zone de conception de cartes s'affiche après que vous avez sélectionné un modèle de carte ou 
ouvert un document existant. Par défaut, seul le recto s'affiche.

  Zoom avant / Zoom arrière
 

  Zoom au niveau le plus adapté pour afficher la 
carte

Afficher le verso

  Reproduire la mise en forme

  Annuler des actions effectuées

  Rétablir des actions annulées

  Enregistrer le document actuel

  Imprimer les cartes sélectionnées

  Fermer le document actuel et retourner à l'interface 
d'accueil
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  Sélectionner les unités de mesure utilisées pour 
dimensionner/positionner les éléments

Vue (View) > Unités de mesure (Measurement 
System)

  Afficher/Masquer la grille servant à 
dimensionner/positionner les éléments 
visuellement

Vue (View) > Afficher la grille (Show Grid)

  Afficher/Masquer des lignes se croisant au centre 
de la carte servant à positionner les éléments 
visuellement

Vue (View) > Repères (Guide Lines)

  Afficher/Masquer les règles indiquant la position 
horizontale et verticale des éléments

Vue (View) > Afficher la règle (Show Rulers)

  Activer/Désactiver l'alignement des éléments sur la 
grille

Vue (View) > Aligner (Snap) > Aligner sur la 
grille (Snap To Grid)

  Afficher/Masquer l'alignement des éléments avec 
d'autres

Vue (View) > Aligner (Snap) > Aligner sur les 
objets (Snap To Objects)

  Indiquer la zone masquée par le support 
d'étiquette

Vue (View) > Afficher l'empreinte du support 
d'étiquette (Show tag holder footprint on card)

  Éléments alignés

lignes bleues fines dans le prolongement de 
l'élément

  Faire pivoter un élément visuellement

 

lignes rouges en pointillé lorsque l'élément est 
pivoté par 90°/180°/270°

   

Arrière-plan sélectionné

ligne rouge en pointillé autour du bord de la carte

Sélectionner un modèle de carte

Sélectionner un modèle de carte prédéfini

   1. Depuis l'interface d'accueil, cliquer sur :

▶  Un assistant affichera une gamme de modèles de carte.
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 2. Cliquer sur le type d'application auquel vos cartes seront dédiées :

 3. Pour affiner la sélection de modèles de carte, utiliser les listes déroulantes et cases à cocher :

 

 4. Pour voir les détails des éléments sur la carte, survoler une carte et cliquer sur l'icône 

d'information : 

 5. Sélectionner un modèle de carte et cliquer sur Créer (Create).

▶  La zone de conception de cartes s'ouvrira, vous permettant d'ajouter et personnaliser des 
éléments sur la carte.

Sélectionner un modèle de carte vierge

   1. Depuis l'interface d'accueil, cliquer sur :

▶  Un assistant affichera une gamme de modèles de carte.

 2. Cliquer sur

▶  Une gamme de modèles de carte vierges seront affichés :

 3. Pour affiner la sélection de modèles de carte, utiliser les filtres :

 4. Sélectionner un modèle de carte et cliquer sur Créer (Create).

▶  La zone de conception de cartes s'ouvrira, vous permettant d'ajouter et personnaliser des 
éléments sur la carte.
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Personnaliser l'arrière-plan de la carte

  Sélectionner un arrière-plan de carte prédéfini

 1. Cliquer dans une zone vide à l'écart d'éléments sur le côté de la carte auquel l'arrière-plan est à 
appliquer.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

 2. Sous Arrière-plan (Background), cliquer sur un des arrières-plans prédéfinis.

 a. Appliquer au recto : cliquer sur l'icône de carte à gauche

 b. Appliquer au verso : cliquer sur l'icône de carte à droite

   

Sélectionner une image comme arrière-plan de la carte

 1. Cliquer dans une zone vide à l'écart d'éléments sur le côté de la carte auquel l'arrière-plan est à 
appliquer.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

 2. Sous Arrière-plan (Background), cliquer sur l'icône répertoire :

 3. Sélectionner un de vos fichiers image.

Mettre en forme l'arrière-plan de la carte

Cliquer dans une zone à l'écart d'éléments sur le côté de la carte dont l'arrière-plan est à modifier.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

    Propriétés images (Image properties)

Couleurs de l'image originale

Niveaux de gris

  Monochrome



Conception de carte Personnaliser l'arrière-plan de la carte

16

  Négatif

 
Si vous imprimez avec un ruban monochrome (un ruban doté d'une seule couleur), les 
images doivent avoir un format monochrome (mais peuvent en plus avoir un format de 
négatif).

  Saturation / Luminosité / Contraste

  Rétablir les réglages d'origine

  Supprimer une couleur de l'arrière-plan de la carte

 1. Cliquer dans une zone à l'écart d'éléments sur le côté de la carte dont l'arrière-plan est à modifier.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

 2. Sous Propriétés images (Image properties) > Supprimer l'arrière-plan (Remove 
background), cliquer sur la petite flèche à droite de l'icône d'un personnage :

 3. Cliquer sur Pipette (Color Picker).

▶  Votre curseur se transformera en pipette.

 4. Cliquer sur un exemple de la couleur à supprimer.

 5. Sous Tolérance (Tolerance), glisser le curseur vers la gauche ou la droite pour ajuster le seuil en 
fonction duquel la couleur sera supprimée.

 6. Pour rétablir la valeur d'origine cliquer sur :

Rogner l'image de l'arrière-plan de la carte

 1. Cliquer dans une zone à l'écart d'éléments sur le côté avec l'image de l'arrière-plan à rogner.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

 2. Cliquer sur : 

 3. Faire glisser les carrés rouges pour enfermer la zone souhaitée de l'image :
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 4. Cliquer sur Rogner (Crop).

Supprimer l'arrière-plan de la carte

 1. Cliquer dans une zone à l'écart d'éléments sur le côté de la carte dont l'arrière-plan est à modifier.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

 2. Cliquer sur la petite flèche à droite de l'icône d'un paysage avec une croix :

Dans la liste déroulante, cliquer sur le côté dont l'arrière-plan est à supprimer :

Ajouter / Personnaliser du texte

  Ajouter du texte

Pour ajouter du texte totalement nouveau

Cliquer sur l'icône de texte :

Pour ajouter du texte à partir d'une colonne existante

Depuis le tableau de données, glisser-déposer l'en-tête de la colonne sur la carte.

▶  Un élément de texte variable, lié à la colonne correspondante dans le tableau de données, apparaîtra 
sur la carte, vous permettant de le modifier.

Vous pouvez rendre le texte fixe ultérieurement.

Modifier du texte

 1. S'il n'est pas déjà sélectionné sur la carte, cliquer sur l'élément de texte.
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 2. Saisir le texte souhaité.

 3. Appuyer sur la touche Entrée.

Si le texte est lié à une colonne du tableau de données, le texte dans la ligne correspondante à la carte 
sera également modifié.

Mettre en forme du texte

Cliquer sur l'élément de texte.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

    Police de caractères (Font)

  Couleur de texte

  En gras / En italique / Souligné / Barré

  Casse (par ex. minuscules)

  Augmenter / Diminuer la taille des caractères

  Police

  Taille des caractères

  Taille des caractères ajustée automatiquement 
pour adapter le texte aux dimensions de l'élément, 
respectant des seuils minimum / maximum En plus de Avancé (Advanced) > Taille de police 

(Font Size)  > Tailles de police minimum et 
maximum (Minimum and maximum sizes)

     

  Positionnement Paragraphe (Paragraph)

  Position verticale au sein de l'élément

  Justification

  Retour à la ligne (pour forcer le texte à commencer 
une nouvelle ligne si nécessaire)

     

  Élément  
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  Couleur d'arrière-plan / cadre

  Reproduire une mise en forme de texte

 1. Cliquer sur l'élément de texte dont la mise en forme est à reproduire.

Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

 2. Cliquer sur l'icône de reproduction de mise en forme :

 3. Cliquer sur l'élément de texte auquel la mise en forme est à appliquer.

Rendre du texte fixe

Les éléments qui sont fixes sont identiques sur toutes les cartes de votre document et figureront sur 
chaque carte.

 1. Faire un clic droit sur l'élément et sélectionner Transformer en texte  / image / code-barres 
fixe.

▶  Une fenêtre s'ouvre pour confirmer la transformation.

 2. Cliquer sur OK pour confirmer.

▶  La colonne liée sera supprimée du tableau de données.

Les données dans cette colonne ne pourront pas être récupérées.

 

Ajouter / Personnaliser une image

  Ajouter une image

Si vous imprimez avec un ruban monochrome (un ruban doté d'une seule couleur), les 
images présentant une gamme de gris/couleurs ne sont pas appropriées.

Pour ajouter une nouvelle image à partir de vos propres fichiers

Cliquer sur l'icône de paysage.  

Ajouter une nouvelle image à partir de la webcam
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L'ordinateur doit être équipé d'une webcam.

 

 1. Cliquer sur l'icône Prendre une photo de la caméra.

 2. Puis cliquer sur l'icône webcam pour prendre la photo.

 3. Cliquer sur Acquérir (Aquire) pour insérer la photo dans le design de carte.

Pour ajouter une image à partir d'une colonne existante

Depuis le tableau de données, glisser-déposer l'en-tête de la colonne sur la carte.

▶  Une image variable, liée à la colonne correspondante dans le tableau de données, apparaîtra sur la 
carte, vous permettant de la mettre en forme, dimensionner et positionner.

Vous pouvez rendre l'image fixe ultérieurement.

Mettre en forme une image

Cliquer sur l'image.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

    Format

  Couleur d'arrière-plan / cadre

    Propriétés images (Image properties)

Couleurs de l'image originale

Niveaux de gris

  Monochrome

  Négatif
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Si vous imprimez avec un ruban monochrome (un ruban doté d'une seule couleur), les 
images doivent avoir un format monochrome (mais peuvent en plus avoir un format de 
négatif).

  Saturation / Luminosité / Contraste

  Rétablir les réglages d'origine

  Supprimer une couleur d'une image

 1. Cliquer sur l'image.

Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

 2. Sous Propriétés images (Image properties) > Supprimer l'arrière-plan (Remove 
background), cliquer sur la petite flèche à droite de l'icône d'un personnage :

 3. Cliquer sur Pipette (Color Picker).

Votre curseur se transformera en pipette.

 4. Cliquer sur un exemple de la couleur à supprimer.

 5. Sous Tolérance (Tolerance), glisser le curseur vers la gauche ou la droite pour ajuster le seuil en 
fonction duquel la couleur sera supprimée.

 6. Pour rétablir la valeur d'origine cliquer sur :

Changer une image

 1. Sur la carte, double-cliquer sur l'image.

 2. Sélectionner un fichier image.

▶  Si l'image est liée à une colonne du tableau de données, l'image dans la ligne correspondante 
à la carte sera également modifiée.

Rendre une image fixe

Les éléments qui sont fixes sont identiques sur toutes les cartes de votre document et figureront sur 
chaque carte.

 1. Faire un clic droit sur l'élément et sélectionner Transformer en texte  / image / code-barres 
fixe.

▶  Une fenêtre s'ouvre pour confirmer la transformation.

 2. Cliquer sur OK pour confirmer.
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▶  La colonne liée sera supprimée du tableau de données.

Les données dans cette colonne ne pourront pas être récupérées.

 

Ajouter / Personnaliser un logo

  Ajouter un logo

Par défaut, un logo est une image fixe sur l'arrière-plan de la carte. Les éléments qui sont fixes sont 
identiques sur toutes les cartes de votre document et figureront sur chaque carte.

 1. Cliquer sur l’icône Ajouter un logo (Add Logo).

▶  Une nouvelle zone d'image est ajoutée au centre de la carte et l'explorateur du système 
d'exploitation s'ouvre.

 2. Sélectionner l'image à utiliser comme logo.

 3. Cliquer sur Ouvrir pour ajouter le logo au design de carte.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.. 

La taille et l'emplacement du logo peuvent être modifiés.

Changer un logo

 1. Sur la carte, double-cliquer sur l'image.

 2. Sélectionner un fichier image.

▶  Si l'image est liée à une colonne du tableau de données, l'image dans la ligne correspondante 
à la carte sera également modifiée.

Modifier l'image source d'un logo

La source de l'image d'un logo peut être changée. La source peut venir du disque dur (depuis un 
dossier rangé sur l'ordinateur ou un serveur) ou la webcam de l'ordinateur.

 1. Dans le zone de conception de carte, cliquer sur le logo.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

 2. Sous Avancé (Advanced), cliquer sur Source image (Image source).

 3. Sélectionner une source dans la liste déroulante.

 4. Une fois la source du logo modifiée, vous pouvez cliquer sur l'icône répertoire.
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 l Quand la source sélectionnée est A partir du disque (From disk), l'explorateur de 
l'ordinateur s'ouvre.

 l Quand la source sélectionnée est Integrated webcam, une fenêtre de capture d'image 
s'ouvre.

 1. Cliquer sur l'icône webcam pour prendre la photo.

 2. Cliquer sur Acquérir (Aquire) pour insérer la photo dans le design de carte.

Ajouter / Personnaliser un code-barres

  Ajouter un code-barres

Pour ajouter un code-barres 1D totalement nouveau

Cliquer sur l'icône de code-barres puis l'icône de code-barres 1D :

  >  

Pour ajouter un code-barres 2D totalement nouveau

Cliquer sur l'icône de code-barres puis l'icône de code-barres 2D :

  >   

Pour ajouter un code-barres 1D à partir d'une colonne existante

Depuis le tableau de données, glisser-déposer l'en-tête de la colonne sur la carte.

▶  Un code-barres, lié à la colonne correspondante dans le tableau de données, apparaîtra sur la carte, 
vous permettant de le modifier.

Vous pouvez rendre le code-barres fixe ultérieurement.

Modifier un code-barres

 1. S'il n'est pas déjà sélectionné sur la carte, cliquer sur le code-barres.

 2. Saisir les données à encoder.

 3. Appuyer sur la touche Entrée.

▶  Si le code-barres est lié à une colonne du tableau de données, les données dans la ligne 
correspondante à la carte seront également modifiées.

Mettre en forme un code-barres 1D

Après avoir mis en forme un code-barres 1D, penser à imprimer une carte d'essai pour 
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s'assurer de la lisibilité du code-barres avant d'imprimer à plus grande échelle.

Cliquer sur le code-barres.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

  Encodage  

    Code-barres (Barcode)

  Normes d'encodage

     

  Optimisation de la lisibilité Avancé (Advanced) > Code-barres (Barcode) > 
Optimiser (Optimize)

  Chiffre supplémentaire utilisé pour vérifier le reste 
des données lues

Avancé (Advanced) > Code-barres (Barcode) > 
Clé de contrôle (CheckDigit)

     

  Dimensions / Disposition

  Largeur des barres verticales Avancé (Advanced) > Code-barres (Barcode) > 
Largeur du module (Module width)

  Rapport des barres verticales Avancé (Advanced) > Code-barres (Barcode) > 
Rendu: (Rendering)

  Espace vide de chaque côté des barres verticales Avancé (Advanced) > Code-barres (Barcode) > 
Marge du code à barres (Quiet Zone)

  Barre(s) encadrant les barres verticales Avancé (Advanced) > Code-barres (Barcode) > 
Cadre (Bearer bar)

  Largeur des barre(s) encadrant les barres verticales Avancé (Advanced) > Code-barres (Barcode) > 
Largeur du cadre (Bearer width)

     

  Caractères visibles

  Afficher les données encodées sous forme de 
caractères visibles sur la carte

Code-barres (Barcode) > Texte du code-barres 
(Human readable)

    Police de caractères (Font)

  Police de caractères (Font)

  Couleur des caractères
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  Taille des caractères

  Largeur totale des caractères ajustée 
automatiquement pour s'adapter à la largeur du 
code-barres

Avancé (Advanced) > Code-barres (Barcode) > 
Ajuster le texte au code barre (Fit Text to 
Barcode)

     

  Couleur

    Police de caractères (Font)

  Couleur du code-barres et des caractères

    Format

  Couleur de l'arrière-plan

  Couleur du cadre

  Mettre en forme un code-barres 2D

Après avoir mis en forme un code-barres 2D, penser à imprimer une carte d'essai pour 
s'assurer de la lisibilité du code-barres avant d'imprimer à plus grande échelle.

Cliquer sur le code-barres.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

  Encodage

    Code-barres (Barcode)

  Jeu de caractères qui peut être encodé Avancé (Advanced) > Code-barres (Barcode) > 
Page de code (Code Page)

  Format d'encodage QRCode Avancé (Advanced) > Code-barres (Barcode) > 
Format QRCode (QRCode Format)

  Format d'encodage Datamatrix Avancé (Advanced) > Code-barres (Barcode) > 
Code Datamatrix (Datamatrix Code)

  Mode d'encodage PDF417 Avancé (Advanced) > Code-barres (Barcode) > 
Encodage PDF417 (PDF417 Encoding)

  Mode d'encodage Maxicode Avancé (Advanced) > Code-barres (Barcode) > 
Mode Maxicode (Maxicode Mode)

  Options pour annexer plusieurs codes-barres 
Maxicode

Avancé (Advanced) > Code-barres (Barcode) > 
Annexer # (Append #)
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  Format d'encodage AZTEC Rune Avancé (Advanced) > Code-barres (Barcode) > 
Mode AZTEC (AZTEC Mode)

     

  Optimisation de la lisibilité Avancé (Advanced) > Code-barres (Barcode) > 
Optimiser (Optimize)

  Ajustement de l'arrangement de la matrice Avancé (Advanced) > Code-barres (Barcode) > 
Masque (Mask)

  Redondance pour assurer la lisibilité si une partie 
du code-barres est sale ou endommagée

Avancé (Advanced) > Code-barres (Barcode) > 
Niveau EC (EC Level)

     

  Dimensions / Disposition

  Nombre de carrés formant la matrice Avancé (Advanced) > Code-barres (Barcode) > 
Taille (Size)  > Taille/Version (Size/Version)

  Taille des carrés formant la matrice Avancé (Advanced) > Code-barres (Barcode) > 
Largeur du module (Module width)

  Hauteur des lignes au sein de la matrice Avancé (Advanced)  > Code-barres (Barcode)  > 
Hauteur des lignes (Row height)

  Largeur des colonnes au sein de la matrice Avancé (Advanced) > Code-barres (Barcode) > 
Largeur de la colonne (Column width)

  Segments de données par ligne Avancé (Advanced) > Code-barres (Barcode) > 
Segments de données (Data Segments)

  Rapport entre les lignes et colonnes Avancé (Advanced) > Code-barres (Barcode) > 
Rapport R/C (R/C Ratio)

  Espace vide autour de la matrice Avancé (Advanced) > Code-barres (Barcode) > 
Marge du code à barres (Quiet Zone)

     

  Couleur

    Police de caractères (Font)

  Couleur des carrés formant la matrice

    Format

  Couleur de l'arrière-plan

  Couleur du cadre

  Rendre un code-barres fixe



Conception de carte Ajouter / Mettre en forme une forme

27

Les éléments qui sont fixes sont identiques sur toutes les cartes de votre document et figureront sur 
chaque carte.

 1. Faire un clic droit sur l'élément et sélectionner Transformer en texte  / image / code-barres 
fixe.

▶  Une fenêtre s'ouvre pour confirmer la transformation.

 2. Cliquer sur OK pour confirmer.

▶  La colonne liée sera supprimée du tableau de données.

Les données dans cette colonne ne pourront pas être récupérées.

 

 

Ajouter / Mettre en forme une forme

  Ajouter une forme

 1. Cliquer sur l'icône de forme :

 2. Puis sur une forme dans le menu :

▶  La forme apparaît sur le carte vous permettant de la mettre en forme, dimensionner et 
positionner :

Mettre en forme une forme

Cliquer sur la forme.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.
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    Format

  Couleur de fond

  Couleur du cadre

Opacité Avancé (Advanced) > Elément (Item) > Opacité 
(Opacity)

Ajouter / Personnaliser une vCard

Une vCard permet d'encoder les informations imprimées sur une carte de visite dans un QR code.  En 
scannant ce QR code, une personne peut créer un nouveau contact dans leur téléphone, localiser 
l'entreprise avec une application GPS, appeler le numéro de téléphone renseigné, envoyer un e-mail à 
l'adresse e-mail renseignée, copier ou partager les informations.

En fonction de la marque du téléphone utilisé pour scanner la vCard, les comportements 
suivants peuvent être observés lors de l'ajout des informations à un nouveau contact :

 l Les champs en lien avec l'adresse (champs 9 à 13) peuvent tous être regroupés 
dans un seul champ du contact.

 l les champs en lien avec l'emploi (champs 4 à 6) peuvent tous être regroupés dans 
un seul champ du contact.

Assurer la bonne lisibilité du QR code vCard
 l Le premier plan (noir par défaut) doit être d'une couleur plus foncée que l'arrière-plan (blanc 

par défaut).
 l La combinaison premier plan jaune et arrière-plan blanc rend le QR code illisible.
 l S'assurer qu'il y a assez de contraste entre le premier plan et l'arrière-plan du QR code.
 l La taille minimum pour une bonne lisibilité est de 2x2 cm.
 l Ajouter un cadre de la même couleur que l'arrière-plan du QR code d'au moins 1/4 pt.

Ajouter une vCard

Cliquer sur l'icône vCard.

▶  Un QR code apparaît sur la carte. Le QR code vCard est affiché sur toutes les lignes de la base de 
données.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

Enregistrer des informations

Mode vCard classique
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 1. S'il n'est pas déjà sélectionné sur la carte, cliquer sur le QR code vCard.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

 2. Sous la section Champs vCard (vCard Fields) :
 l Vous pouvez lier chaque champ à une colonne du tableau de  données existant.

 a. Cliquer sur la flèche à côté du champ Sélectionnez la colonne… (Choose 
Column).

 b. Sélectionner le colonne de votre tableau de données.
 l Vous pouvez renseigner les informations manuellement.

Les informations renseignées manuellement sont attribuées à toutes les 
lignes de la base de données.

 

▶  Les informations enregistrées pour la ligne sélectionnée sont affichées en-dessous :

La photo de contact est disponible uniquement quand le mode vCard 
dynamique est activé.

Mode vCard dynamique

Avec le mode vCard classique, les informations sont stockées dans le QR code même. Plus il y a de 
champs vCard remplis, plus le QR code est dense, ce qui peut le rendre illisible en fonction de sa taille.
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5 champs vCard remplis 15 champs vCard remplis

Avec le mode vCard dynamique, le QR code stocke seulement une URL et ne change pas quand de 
nouveaux champs sont remplis. Toutes les informations sont stockées sur une serveur publique 
Badgy. Cela rend le QR code moins dense. Quand le QR code est scanné, les informations de contact 
sont téléchargées sur le téléphone via l'URL.

L'ordinateur doit être connecté à Internet pour utiliser le mode vCard dynamique.

Au moment de scanner le QR code vCard, le téléphone doit être connecté à Internet 
(données mobiles ou WI-Fi).

Quand le mode vCard dynamique est activé, toujours enregistrer le document après toute 
modification sur un QR code vCard. Avant l'enregistrement du document, le QR code est 
illisible et les informations ne sont pas enregistrées / mises à jour sur le serveur.

Pour activer le mode vCard dynamique :

Quand le mode vCard dynamique est utilisé :
 l Supprimer une ligne du tableau de données rend les informations liées à cette 

ligne indisponibles. Scanner le QR code vCard sur une carte précédemment 
imprimée ne donnera plus accès aux informations de contact.

 l Supprimer le QR code vCard d'un design de carte rend les informations liées à ce 
QR code indisponibles. Scanner des cartes précédemment imprimées de donnera 
plus accès aux informations de contact.

 l Travailler sur 2 copies du même document Badge Studio (copié depuis 
l'explorateur Windows ou macOS Finder) entraînera des incohérences si des lignes 
sont ajoutées, modifiées ou supprimer dans un document mais pas dans l'autre.

 l Quand un document est Enregistré sous..., les 2 versions du document ont des QR 
codes vCard différents. Les deux versions du documents peuvent être utilisées sans 
incohérences.

 1. S'il n'est pas déjà sélectionné sur la carte, cliquer sur le QR code vCard.

 2. Sous Champs vCard (vCard Fields), cocher la case Activer le mode vCard dynamique 
(Activate dynamic vCard mode).

 3. Une fenêtre pop-up s'affiche pour vous informer que de nouveaux QR codes vCard vont être 
créés pour chaque ligne du tableau de données et qu'il faudra réimprimer toutes les cartes.

 4. Cliquer sur Oui pour activer l'option.
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 5. Cliquer sur l'icône Enregistrer (Save).

Modifier des informations vCard

 1. S'il n'est pas déjà sélectionné sur la carte, cliquer sur le QR code vCard.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

 2. Cliquer sur Effacer le contenu (Delete content) pour vider tous les champs et saisir de 
nouvelles informations.

OU

 3. Modifier l'information directement dans la base de données.

▶  L'information est modifiée sur la carte et dans l'aperçu des champs vCard.

 4. Cliquer sur l'icône Enregistrer (Save).

Mettre en forme un QR code vCard

S'il n'est pas déjà sélectionné sur la carte, cliquer sur le QR code vCard.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

    Format

  Couleur du QR code

  Couleur de l'arrière-plan

  Couleur du cadre

  Reproduire la mise en forme

    Format > Motif (Pattern)

  Modifier la forme du motif du QR code vCard

    Format > Organiser (Arrange)

  Aligner le QR code précisément
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  Faire pivoter le QR code précisément

  Déplacer le QR code vers l'avant / l'arrière

  Personnaliser un QR code vCard

Les QR codes vCard peuvent être personnalisés en ajoutant une image au QR code (comme le logo de 
votre entreprise).

Logo au centre du QR code vCard

Ajouter un logo au centre d'un QR code vCard

 1. S'il n'est pas déjà sélectionné sur la carte, cliquer sur le code-barres QR  code vCard.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

 2. Sous Logo, cliquer sur l'icône de répertoire et sélectionner l'image que vous voulez ajouter.

 3. ▶  Le logo est ajouté au centre du QR code vCard avec un fond blanc si nécessaire.
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Modifier la taille d'un logo dans un QR code vCard

 1. S'il n'est pas déjà sélectionné sur la carte, cliquer sur le QR code vCard.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

 2. Utiliser la jauge pour ajuster la taille du logo.

Petit : le logo occupe 5% du QR code.

Moyen : le logo occupe 8% du QR code (réglage par défaut).

Large : le logo occupe 11% du QR code.

Supprimer un logo d'un QR code vCard

 1. S'il n'est pas déjà sélectionné sur la carte, cliquer sur le QR code vCard.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

 2. Sous Logo, cliquer sur l'cône restaurer à côté de Parcourir fichier (Browse file) :

▶  Le logo est supprimé du QR code vCard et de l'aperçu du logo sélectionné.

Dimensionner / positionner les éléments

Rogner une image

  Cliquer sur l'image.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

Pour remplir entièrement le cadre existant

Sous Avancé (Advanced) > Ajuster (Fit), cliquer sur Recadrer (Crop to Fit).

Pour afficher l'image entière dans son cadre existant

Sous Avancé (Advanced) > Ajuster (Fit), cliquer sur Mettre à l'échelle (Shrink to fit).

Pour rogner une zone spécifique de l'image

 1. Sous Format, cliquer sur l'icône Rogner.

 2. Faire glisser les carrés rouges pour enfermer la zone souhaitée de l'image :
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 3. Cliquer sur Rogner (Crop).

Pour rogner une image selon une forme

 1. Sous Format, cliquer sur la petite flèche à droite de l'icône avec deux formes entrecroisées :

 2. Puis sélectionner une des formes listées :

▶  Des parties de l'image seront masquées pour adapter l'image à la forme sélectionnée :

Déplacer un élément sur l'autre côté de la carte

 1. Si le verso de la carte n'est pas affiché, cliquer sur 

 2. Cliquer sur l'élément, positionnant le curseur vers son cadre pour que la flèche à quatre têtes 
apparaisse.

 3. Cliquer sur l'élément et le glisser-déposer vers l'autre côté de la carte.
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Déplacer un élément vers l'avant / arrière

  Dans le même espace, les parties des éléments sur un plan vers l'avant masqueront celles des éléments 
sur un plan vers l'arrière. Les éléments sur la carte occupent chacun un plan qui détermine leur visibilité 
par rapport aux autres.

Pour un plan vers / à l'avant

Faire un clic droit sur un élément puis cliquer sur Avancer (Bring forward) ou Mettre au premier plan 
(Bring to front).

Pour un plan vers / à l'arrière

Faire un clic droit sur un élément puis cliquer sur Reculer (Send backward) ou Mettre à l'arrière-plan 
(Send to back).

Redimensionner un élément pour remplir la carte pro-
portionnellement

  Faire un clic droit sur un élément puis cliquer sur Ajuster à la carte (Fit to Card).

Aligner / Distribuer les éléments

   1. Maintenir la touche Ctrl (Windows) / cmd (macOS) enfoncée et cliquer sur les éléments à 
aligner/distribuer.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

 2. Sous Format > Organiser (Arrange), cliquer sur l'icône d'alignement puis sélectionner une 
option :

Faire pivoter un élément précisément

   1. Cliquer sur l'élément à faire pivoter.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.
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 2. Sous Format > Organiser (Arrange), cliquer sur la petite flèche à droite de l'icône de rotation et 
choisir une des options prédéfinies ou saisir l'angle de rotation dans le champ :

Dimensionner / Positionner un élément précisément

   1. Cliquer sur l'élément à dimensionner / positionner.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

 2. Sous Avancé (Advanced), cliquer sur Taille (Size) > Position.

 3. Saisir la largeur/hauteur/position dans le champ :

Verrouiller / masquer des éléments

Verrouiller / Déverrouiller un élément sur la carte

   1. Cliquer sur l'élément.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

 2. Sous Avancé (Advanced) > Elément (Item), cocher / décocher Verrouiller l'élément (Lock 
item).

Verrouiller tous les éléments sans mot de passe

  Dans la zone de conception de cartes, cliquer sur l'icône de cadenas (et non la petite flèche à droite) : 

▶  Les données dans le tableau de données liées aux éléments sur la carte ne seront pas verrouillées.

Vous pourrez toujours imprimer des cartes.
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Verrouiller les éléments sur la carte par mot de passe

 1. Cliquer sur la petite flèche à droite de l'icône du cadenas,

 

Puis cliquer sur Verrouiller le modèle par mot de passe (Lock design with password) > .

 2. Saisir et confirmer le mot de passe de votre choix :

  

Vous ne pouvez pas réinitialiser le mot de passe si vous l'oubliez.

 

 3. Cliquer sur OK.

Les données dans le tableau de données liées aux éléments sur la carte ne seront pas 
verrouillées.

Vous pourrez toujours imprimer des cartes.

Déverrouiller les éléments sur la carte

   1. Dans la zone de conception de cartes, cliquer sur l'icône de cadenas (et non la petite flèche à 
droite) :

 2. Saisir le mot de passe défini précédemment.

 3. Cliquer sur OK.

 
Cette action ne déverrouille pas les colonnes verrouillées liées à des éléments sur la carte.

Désactiver le verrouillage par mot de passe

 1. Dans la zone de conception de cartes, cliquer sur la petite flèche à droite de l'icône de cadenas
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Puis cliquer sur Désactiver la protection par mot de passe (Disable password protection).

 2. Saisir le mot de passe défini précédemment.

 3. Cliquer sur OK.

Masquer / Afficher des éléments sur la carte

  Dans l'en-tête de la colonne liée à l'élément, cliquer sur l'icône de l’œil.

 / .

Un élément masqué ne sera pas imprimé.

Copier / supprimer des éléments

Copier-coller un élément

   1. Faire un clic droit sur un élément puis cliquer sur Copier (Copy).

 2. Faire un clic droit sur le côté et dans la zone où vous souhaitez ajouter la copie puis cliquer sur 
Coller (Paste).

▶  Si variable, l'élément dupliqué sera lié à une nouvelle colonne dans le tableau de données.

Dupliquer un élément

  Faire un clic droit sur un élément puis cliquer sur Dupliquer (Duplicate).

Si variable, l'élément original et les éléments dupliqués seront liés à la même colonne dans 
le tableau de données, et mis à jour conjointement si n'importe lequel d'entre eux est 
modifié.

Supprimer un élément

  Faire un clic droit sur un élément puis cliquer sur Supprimer (Delete).

Toute colonne liée ne sera pas supprimée du tableau de données.
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Gestion des données
Tableau de données

 Le tableau de données au-dessous de la zone de conception de cartes contient les données qui peuvent être 
affichées sur vos cartes. Il s'organise en colonnes* (chacune regroupant des données d'un certain type) et 
lignes* (chacune correspondant à une carte).

 Ajouter une ligne

 Naviguer entre les lignes (et afficher les 
cartes correspondantes)

 Rechercher des données

 Sélectionner une, plusieurs ou toutes les 
lignes

 

 Supprimer la/les ligne(s) sélectionnées

Ajouter une ligne

  Au pied du tableau de données, cliquer sur l'icône plus :

▶  Une ligne basée sur le même modèle de carte et contenant les mêmes éléments que les autres 
cartes sera ajoutée à votre document.

Vous pouvez modifier les données directement dans les cellules de cette ligne.

Ajouter une colonne

   1. Faire un clic droit sur n'importe quel en-tête de colonne.

 2. Cliquer sur Ajouter une colonne (Add column) et sélectionner le type de colonne à ajouter 
(Ajouter une colonne code barres (Add barcode column) / Ajouter colonne image (Add 
image column) / Ajouter un colonne texte (Add text column)).

Vous pouvez ajouter des éléments liés à la carte ultérieurement (texte, image, code-barres).
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Ajouter / importer des données

Préparer une base de données externe

  Préparer une base de données de type tableur

Les règles suivantes doivent être respectées :
 l Les données pouvant être importées sont des objets disponibles dans le logiciel (zone de texte, 

images, informations de code-barres, logo, etc.).
 l Remplir la feuille de calcul comme suit : nom des colonnes en première ligne du tableur et 

valeurs à afficher dans les lignes qui suivent.
 l Éviter d'inclure des cellules fusionnées. Elles ne peuvent pas être importées dans le logiciel.
 l Pour inclure des images dans une base de données de type tableur, utiliser la fonctionnalité Lien.

Préparer une base de données .txt

Les règles suivantes doivent être respectées :
 l la première ligne doit servir de d'exemple pour tout le fichier .txt. La ligne correspond aux titre 

des colonnes de la base de données. (1)
 l Toujours suivre l'exemple de la première ligne pour remplir le fichier .txt.
 l Pour ajouter des images, utiliser le chemin complet et le nom de l'image (avec l'extension du 

fichier).
 l Si les lignes doivent être importées dans un ordre précis, ajouter un chiffre comme première 

entrée. Ajouter un nom de colonne aux numéros de ligne pour qu'ils ne soient pas importés 
comme entrées. (2)

 l Séparer chaque élément par un délimiteur : virgule (,) ou point-virgule (;). (3)

Si aucun délimiteur n'est détecté, l'import ne se passera pas correctement.
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Importer des données

Importer des données depuis un document Excel  / CSV / .txt

Sélectionner le fichier à importer

 1. Ouvrir le document Badge Studio vers lequel vous souhaitez importer les données.

 2. Cliquer sur Fichier (File) > Importer des données (Import data).

▶  La fenêtre d'importation s'affiche.

 3. Cliquer sur l'onglet Importation (Import) > Importer depuis Excel / CSV / TXT (Import from 
EXCEL / CSV / TXT)

 4. Cliquer sur Parcourir fichier (Browse file) puis sélectionner le document contenant les données 
à importer.

Pour préciser les données dans un document Excel à importer :

 1. Cocher Options Avancées (Advanced options).

 2. Sélectionner la feuille dans la liste déroulante et / ou préciser l'étendue de cellules 
contenant les données :

Pour synchroniser les données avec un document Excel :

 1. Cocher Options Avancées (Advanced options).

 2. Cocher Rafraîchissement automatique des données (Auto Import Data).

 3. Sélectionner une des options décrites.

 5. Cliquer sur Suivant (Next >).

  Lier les éléments sur la carte à des colonnes du fichier.

▶  La boîte de dialogue affichera les éléments sur votre modèle de carte à gauche et les colonnes du 
document importé à droite :
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 1. Cliquer sur Afficher d'autres colonnes de mon tableau (Show more columns from my table) 
pour afficher des colonnes dans votre tableau de données non liées à des éléments sur la carte.

▶  Les colonnes seront affichées au-dessous de la carte :

 2. Cliquer sur l'élément (ou colonne) à gauche puis cliquer sur la colonne correspondante à droite 
pour chaque élément (ou colonne non liée) à lier à une colonne du document importé.

▶  Les éléments et colonnes liés afficheront un point dont le numéro et la couleur sont 
identiques :

Pour préciser une ou plusieurs colonnes de référence :

 1. Cliquer sur Avancé (Advanced).

 2. Si elle n'est pas déjà cochée, cocher la case à côté de la colonne du document 
importé.

 3. Cliquer l'icône de clef à côté de la colonne du document importé : 

▶  Les colonnes de référence seront indiquées par une icône de clef bleue :

 4. Cliquer sur OK.

 3. Lorsque vous avez fini de lier les éléments et colonnes, cliquer sur Suivant (Next >) puis 
Terminer (Finish).
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Modifier des données

Modifier des données de type texte dans le tableau de données

   1. Faire un double-clic sur la cellule du tableau de données (dans la ligne de la carte 
correspondante) contenant la valeur à modifier.

 2. Saisir la valeur souhaitée dans la cellule du tableau de données.

 3. Appuyer sur la touche Entrée.

▶  La valeur sur la carte correspondante à la ligne sera également modifiée.

Changer une image dans le tableau de données

   1. Faire un double-clic dans la cellule du tableau de données (dans la ligne de la carte 
correspondante) contenant l'image à changer.

▶  L'explorateur de l'ordinateur s'ouvre.

 2. Sélectionner un fichier image.

▶  L'image sur la carte correspondante à la ligne sera également modifiée.

 

Lier un élément à une autre colonne

  Quand un nouvel élément est ajouté à la carte, une colonne correspondante est automatiquement 
créée dans le tableau de données. L'élément peut être lié à une autre colonne du tableau de données 
(si vous avez déjà importé une base de données contenant les informations pour l'élément).

 1. Cliquer sur l'élément sur la carte.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

 2. Sous Avancé (Advanced)  > Base de données (Database), dans la liste déroulante, sélectionner 
la colonne à lier.

▶  L'élément est maintenant lié à une nouvelle colonne et les données affichées sur la carte sont 
mises à jour.

Rendre un élément fixe

  Les éléments qui sont fixes sont identiques sur toutes les cartes de votre document et figureront sur 
chaque carte.

 1. Faire un clic droit sur l'élément et sélectionner Transformer en texte  / image / code-barres 
fixe.

▶  Une fenêtre s'ouvre pour confirmer la transformation.

 2. Cliquer sur OK pour confirmer.

▶  La colonne liée sera supprimée du tableau de données.
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Les données dans cette colonne ne pourront pas être récupérées.

Renommer une colonne

   1. Faire un clic droit sur l'en-tête de colonne puis cliquer sur Renommer la colonne (Rename 
column).

 2. Saisir le nouveau nom de la colonne directement dans l'en-tête de la colonne.

 3. Appuyer sur la touche Entrée.

Rechercher / Trier des données

Rechercher des données

   1. Saisir l'information que vous recherchez dans la barre de recherche (texte / les données de code-
barres) :

 2. Sélectionner une colonne dans la liste déroulante à droite de la barre de recherche pour affiner la 
recherche :

▶  Seules les lignes correspondant exactement aux critères de recherche seront affichées.

 3. Supprimer tous les caractères dans le champ de recherche pour réafficher toutes les lignes.

Réarranger les colonnes

  Faire un clic droit sur un en-tête de colonne puis cliquer sur Déplacer vers la gauche (Move left) ou 
Déplacer vers la droite (Move right).

Verrouiller / masquer des données

Verrouiller / Déverrouiller une colonne

 1. Faire un clic droit sur l'en-tête de colonne puis cliquer sur Options Avancées (Advanced 
options).

 2. Cocher / Décocher Protéger la colonne (Protect column).

▶  Les données dans une colonne verrouillée ne peuvent pas être modifiées, copiées ou 
supprimées.
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Tout élément lié à une colonne verrouillée peut être personnalisé, dimensionné et 
positionné.

Masquer une colonne

  Faire un clic droit sur l'en-tête de colonne puis cliquer sur Masquer (Hide).

▶  Les éléments correspondants sur la carte seront aussi masqués.

Afficher une colonne

   1. Faire un clic droit sur n'importe quel en-tête de colonne puis cliquer sur Afficher (Unhide).

 2. Cocher la case de la colonne à afficher.

▶  L'élément correspondant sur les cartes sera également affiché.

Copier / exporter des données

Copier-coller une ligne

   1. Faire un clic droit sur n'importe quelle cellule de la ligne contenant les données à copier puis 
cliquer sur Copier la ligne (Copy line).

 2. Faire un clic droit sur n'importe quelle cellule de la ligne contenant les données à remplacer puis 
cliquer sur Coller la ligne (Paste line).

▶  Les données existantes dans la ligne seront remplacées.

Dupliquer une ligne

  Faire un clic droit sur n'importe quelle cellule de la ligne contenant les données à dupliquer puis cliquer 
sur Dupliquer la ligne (Duplicate row).

▶  Une ligne contenant les mêmes données sera ajoutée au tableau de données.

Vous pouvez modifier ultérieurement cette ligne sans que l'autre ligne soit mise à jour.

Propager une valeur / image à la colonne entière

   1. Faire un clic droit sur la cellule du tableau de données contenant la valeur / image à propager.

 2. Sélectionner Appliquer cette image à toutes les lignes (Apply image to all rows) / 
Appliquer cette valeur à toutes les lignes (Apply value to all rows).

▶  La valeur / image sera propagée à toutes les cellules de la même colonne.

Vous pouvez modifier ultérieurement toute cellule de cette colonne sans que les autres 
cellules soient mises à jour.
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Exporter des données

 1. Ouvrir le document contenant les données à exporter.

 2. Cliquer sur Fichier (File) > Exporter les données (Export data).

 3. Cliquer sur l'icône répertoire :

 4. Sélectionner l'emplacement où les données seront stockées.

 5. Décocher les cases des colonnes que vous ne voulez pas exporter.

 6. Cliquer sur Exporter (Export).

▶  Dans l'emplacement sélectionné, un dossier compressé contenant un fichier Excel des 
données exportées est sauvegardé.

Supprimer des données

Supprimer des lignes

   1. Sélectionner les lignes à supprimer.  

   l Pour sélectionner une ou plusieurs lignes à 
supprimer, cocher la ou les case(s) des lignes.

   l Pour sélectionner une plage de lignes à 
supprimer, cocher la case à un bout de la 
plage de lignes, maintenir la touche Maj 
enfoncée et cocher la case à l'autre bout de la 
plage.

   l Pour sélectionner toutes les lignes à 
supprimer, cocher la case au-dessus de la 
case de la première ligne.

   2. Cliquer sur l'icône de poubelle.

Les données supprimées ne peuvent 
pas être récupérées.
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Supprimer une colonne

  Faire un clic droit sur l'en-tête de colonne puis cliquer sur Supprimer la colonne (Delete column).

Les données supprimées ne peuvent pas être récupérées.

Tout élément lié sur la carte sera également supprimé.
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Impression
Interface d'impression

  L'interface d'impression s'affiche après que vous avez sélectionné les cartes à imprimer et cliqué sur 
l'icône d'imprimante dans la zone de conception de cartes Elle vous permet de configurer les 
paramètres d'impression avant de lancer l'impression.

  Rafraîchir la liste d'imprimantes disponibles

  Format de carte Taille de la carte (Card size):

Carte longue 120 x 50 mm (Long card 120 x 50 mm)

Carte longue 150 x 50 mm (Long card 150 x 50 mm)

  Cartes de la taille d'une carte de crédit courante CR80

  Conformité à la norme ISO précisant les 
caractéristiques physiques des cartes

CR80 (ISO7810)

  Pour imprimer le recto

Pour imprimer le verso

  Pour imprimer en recto-verso

  Lissage (Anti-aliasing) Avancé (Advanced) > Rendu: (Rendering) 
> Lissage (Anti-aliasing)

  Résolution d'impression Avancé (Advanced) > Réglages de l'imprimante 
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(Printer settings) > Résolution (DPI) (Resolution 
(DPI))

  Orientation du contenu du verso par rapport au 
recto

Avancé (Advanced) > Réglages de l'imprimante 
(Printer settings) > Retourner le verso de 180 
degrés (Rotate Back 180 degrees)

  Pour lancer l'impression

Imprimer des cartes

Vérifier l'imprimante (Windows)

  Ouvrir Badgy Print Center (par exemple depuis le menu Démarrer de Windows ou une icône sur le 
bureau).

Le statut de l'imprimante devrait être Prêt (Ready) :

Si le statut de l'imprimante n'est pas "Prêt (Ready)", consulter les ressources de support (y compris le 
guide utilisateur) pour les imprimantes Badgy.

Sélectionner les cartes à imprimer

  Pour sélectionner une ou plusieurs lignes à 
imprimer, cocher la ou les case(s) des lignes.

  Pour sélectionner une plage de lignes à imprimer, 
cocher la case à un bout de la plage de lignes, 
maintenir la touche Maj enfoncée et cocher la case 
à l'autre bout de la plage.

https://myplace.evolis.com/s/product/badgy-200/01t5p00000CXScjAAH?language=en_US&tabset-4085f=1
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  Pour sélectionner toutes les lignes à imprimer, 
cocher la case au-dessus de la case de la première 
ligne.

 

Configurer pour ne pas imprimer un élément

   1. Cliquer sur l'élément sur la carte.

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

 2. Sous Avancé (Advanced)  > Elément (Item), décocher Imprimer (Print).

Configurer pour ne pas imprimer l'arrière-plan de la carte

   1. Cliquer sur Modifier (Edit) > Modifier l'arrière-plan (Edit card background).

▶  Le panneau de propriétés s'affichera à droite de la zone de conception de cartes.

 2. Sous Avancé (Advanced) > Arrière-plan (Background), cocher Ne pas imprimer l'arrière-
plan (Don't Print Background).

Configurer / Lancer l'impression

   1. Cliquer sur l'icône d'imprimante dans la zone de conception de cartes :

▶  L'interface d'impression s'affichera :

 2. Configurer les paramètres d'impression disponibles

 3. Cliquer sur l'icône Imprimer (Print) lorsque vous avez configuré les paramètres d'impression.

Cocher la case Impression du verso à l'aide de l'assistant d'impression double face. (Print the 
back side using the duplex printing wizard)
▶  Un assistant s'ouvrira : 
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Suivre les instructions à l'écran.
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Références & aide
  Concepts d'impression
  lissage

Une technique qui vise à un rendu plus lisse de pixels, atténuant 
l'aspect dentelé de bords. Les paramètres d'impression vous 
permettent de préciser si le lissage s'applique au texte, aux images ou 
aux deux.

   

  luminosité

La mesure dans laquelle une image semble rayonner de lumière. Une 
luminosité plus élevée décale la gamme de tons vers le blanc.

faible élevée

  contraste

La différence entre les parties sombres et claires d'une image. Un 
contraste élevé élargit la gamme de tons, accentuant les différences 
entre les parties sombres et claires d'une image. Sur le plan physique, 
avec un contraste plus élevé, la tête d'impression est chauffée à une 
température plus élevée et davantage de colorant est appliqué à la 
carte.

faible élevée

  niveaux de gris

Des nuances depuis le noir absolu jusqu'au blanc absolu. En revanche, 
une image monochrome manque de telles nuances entre le noir 
absolu et le blanc absolu.

 

  monochrome

Ce terme signifie 'une couleur', mais les enjeux pratiques varient selon 
le domaine.

En photographie et graphisme, une image monochrome est composée 
uniquement du noir absolu et du blanc absolu, sans nuances de gris 
ou autres couleurs entre ces extrêmes.

En impression, un ruban monochrome n'a qu'une seule couleur 
(d'habitude le noir ou le blanc) et, par conséquent, soit applique la 
couleur de son colorant, soit n'applique pas de colorant du tout.

Lorsque vous imprimez une image avec un ruban monochrome, il faut 
:

 l Sélectionner une image qui a des zones claires et sombres 
nettes. Elle ne doit pas avoir de nuances de gris ou d'autres 
couleurs.

 l Convertir les images en format monochrome. Badge Studio offre 

 



Références & aide Types de code-barres

53

cette option de mise en forme pour une image ajoutée à la carte 
ou pour l'arrière-plan de la carte.

  négatif

Une image où les couleurs sombres et claires ont été inversées. Dans 
une image monochrome, le noir absolu et le blanc absolu sont 
inversés. Ceci s'avère particulièrement utile lors d'imprimer avec un 
ruban blanc sur des cartes noires.

 

  résolution d'impression

La résolution d'impression représente la densité de points de colorant 
appliqués par la tête d'impression à la carte. Elle se mesure en points 
par pouce (dpi). Augmenter la résolution d'impression peut améliorer 
la qualité des images ayant des détails fins, mais réduit la vitesse 
d'impression.

Les résolutions d'impression possibles dépendent du modèle 
d'imprimante et du type de ruban (monochrome ou couleur) :

Imprimante couleur / monochrome résolution (dpi)

BADGY 100 monochrome 300

BADGY 200 monochrome 300

   

  saturation

La mesure dans laquelle les couleurs d'une image semblent vives.

faible élevée

  Types de code-barres
  Code-barres 1D

Code-barres classique qui encode des données par moyen de barres 
verticales.

 

  Code-barres 2D

Code-barres qui encode des données dans une matrice formée de 
petits carrés.

Les codes-barres 2D sont capables d'encoder davantage de données 
que les codes-barres 1D. Ils peuvent donc être utilisés pour des 
adresses web ou des informations de lot détaillées.

 

  QR Code

Marque déposée. Une norme d'encodage pour les codes-barres 2D.
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  Formats de carte
  carte de crédit

Cartes de la taille d'une carte de crédit courante (86 x 54 mm), fournies 
avec les solutions.

   

  Aide

Télécharger un PDF

Vous pouvez télécharger une version de ce guide au format PDF depuis www.evolis.com  > Section 
support > Page produit.

Le PDF est aussi accessible depuis le bouton Aide (Help) du logiciel.

Vidéo de prise en main

La vidéo de prise en main présente les fonctions les plus importantes offertes par Badge Studio. Elle 
démarrera lorsque vous lancez le logiciel pour la première fois.

Vous pouvez lancer la vidéo de prise en main à n'importe quel moment depuis l'interface d'accueil en 
cliquant sur Aide (Help) > Lancer la vidéo de prise en main (Launch guided tour video).

Tutoriels

Regarder les tutoriels vidéos sur la chaîne YouTube Badgy.

Base de connaissances

Rechercher dans la base de connaissances en ligne.

Assistance technique

 l Contacter le service support de votre revendeur.
 l Remplir ce formulaire en ligne.

https://fr.evolis.com/
https://www.youtube.com/@badgycardprinter/featured
https://myplace.evolis.com/s/topic/0TO5p000001UPchGAG/evolis-badge-studio?
https://myplace.evolis.com/s/contactsupport??language=fr
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C

colonne
Une colonne regroupe des données d'un certain type dans le tableau de données. Par exemple, 
une colonne nommée 'Origine' avec un nom de lieu pour chaque ligne (représentant une carte). 
Lorsqu'une colonne est liée à un élément variable sur la carte, elle sert de source de données.

colonne de référence
Une colonne qui sert à identifier et gérer des doublons de lignes. La colonne de référence peut 
être définie automatiquement par le logiciel ou définie par l'utilisateur. Elle peut être, ou non, 
une colonne liée à un élément sur la carte. Il est possible de définir plus d'une colonne de 
référence pour les mêmes données si une seule colonne de référence ne suffit pas pour 
identifier les lignes de manière unique.

D

document
Un fichier Badge Studio (avec une extension en .bs) contenant un tableau de données et un 
modèle de carte pour une série de cartes.

données
Le texte, les images, les données encodées par des codes-barres et les informations sur les 
allergènes qui sont contenus dans le tableau de données.

E

élément
Les éléments qui peuvent être ajoutés au modèle de carte et personnalisés / mis en forme. Un 
élément variable est lié à une colonne du tableau de données.

F

fixe
les éléments du modèle de carte qui sont fixes (par opposition à variables) sont identiques sur 
toutes les cartes de votre document et figureront sur chaque carte. Par exemple, il se peut que 
vous souhaitiez ajouter une image fixe de votre logo qui figurera sur chaque carte.

L

ligne
Chaque ligne du tableau de données contient les données pour une seule carte. Chaque 
nouvelle ligne ajoutée au tableau de données ajoute une carte correspondante à la série de 
cartes.
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M

Modèle
Les modèles de carte fournis par Evolis sont disponibles dans la cartothèque. Les modèles sont 
déjà pourvus d'un arrière-plan et de plusieurs objets qui peuvent être édités et personnalisés 
par l'utilisateur.

T

tableau de données
Le tableau de données contient et gère les données qui peuvent être représentées sur les cartes 
de votre document.  Il s'organise en colonnes et lignes.

V

valeur
Une valeur correspond aux données spécifiques propres à une seule cellule du tableau de 
données.

variable
Les éléments du modèle de carte qui sont variables (par opposition à fixes) vous permettent de 
les varier de carte en carte, ou les omettre des cartes de votre choix. Par exemple, une image 
variable peut représenter les éventuels allergènes qu'un produit contient.
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